Music Logs
At the Natural Music main screen, select [Logs]. This section of the Natural Music system allows you
to generate and edit Music Logs. These logs can be printed for a live DJ's use or converted into
Automation Logs if you are using an Automation system.

New Music Log
Click [New] to generate a new Music Log for a day. These Music Logs should be generated in
chronological order such as 02-01-12 then 02-02-12, etc. To skip forward or back, use the small
Up/Down keys to the right of the log date.

Delete [Unschedule] Music Logs
Click [Logs] and select an existing Music Log. Then click [Delete] to unschedule an existing Music
Log. This process will restore all Music Category stacks and history information to the condition
existing before the Music Log was generated. Music Logs should be rejected in the reverse order
that they were generated to be sure the Music Category stacks are restored to their original order.

Send Log to Automation
In the Music Log Editor, click [Convert][Automation Log] to create a Log in the appropriate format
for the Automation system selected in Natural Music [Setup] [Station]. See Automation Interfacing
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Music Log Editor
At the Natural Music main screen, select [Logs]. Select an existing Music Log and then click [Open].
Warning When editing Music-Logs, NM5 warns only for Artist-Separation and Also-Protect
violations because these violations may not be obvious and may stretch across several hours.
For other rules, NM5 assumes the user sees surrounding songs and other violations. PlayHistories and reported violations are base on the fixed "Scheduled-Clock-Time" from your
Format Clocks, not the "Estimated-Run-Time" which constantly changes as the log is edited .

Changing the Log Editor Display
You select which song properties are displayed on the Log Editor screen by select [View][Columns]
from the menu on the Log Editor. Simply add or remove the desired properties to be displayed and
the Music Log Editor will display only your selected properties. You may also switch between
[Scheduled-Clock-Times] and [Estimated-Run-Times] using the [View] menu.

Rearranging Songs on Music Log
To move songs around the Music Log, [Left-Click] and hold the mouse button on a song and
dragging it to a new location on the Music Log. Release the button to drop the song into the slot.

Swapping Songs on Music Log
You can use the [Ctrl] key combined with [Left-Click] of the mouse to highlight 2 songs to
automatically swap log positions. Then click [Edit][SwapLines] to automatically swap the items'
positions on the log. This only works when you have exactly 2 lines highlighted in red using the
[Ctrl][Left-Click] method.
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Music Log Editor (cont)

Inserting Alternate Songs onto Music Log
[Left-Click] and hold the mouse button on an alternate song and drag it to where you'd like it to
appear and release the mouse button. If there is already a song at that location it will be removed
and the alternate song will replace it. You may also highlight a song in the Alternate Songs Window
and click [Swap] to swap the alternate song in place of the originally logged song.

ClipBoard - Cutting and Pasting Music Log
The ClipBoard is a temporary container to hold items while cutting, copying, and pasting on the Music
Log.


To begin, select one or more items in the Music Log by slowly dragging your mouse over them
while holding the [Right] mouse button. The selected items will turn red.



You may then click [Edit][Cut] to move the items to the ClipBoard. Click [Edit][Copy] to copy
the items to the ClipBoard.



If you have items on the ClipBoard, you may click [Edit][Paste] to insert all items on the
ClipBoard onto the Music Log at the current Music Log position. Any Cuts or Copies from the
Music Log will clear any existing items from the ClipBoard before the Cut or Copied items are
placed on the ClipBoard.



You may Drag-and-Drop individual items from the ClipBoard onto the Music Log or you may
Paste the entire contents of the ClipBoard at the currently-selected Music Log position.
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Music Log Editor (cont)
Inserting Lines on Music Log
To add a blank line into the Music Log, highlight the spot where you'd like it to appear and click on
the menu Edit Insert. You can then add a song or text.

Deleting Lines from Music Log
To delete a text line or a song from the Music Log, highlight the line(s) you'd like to delete and click
on the menu Edit Delete. To highlight (select) more than one line for deletion, [Right-Click] and hold
the right mouse button down while you move the mouse over the lines to be deleted. Release the
right mouse button and then [Left-Click] Edit Delete.

Undo Music Log Edit
You may click [Edit][UnDo] to reverse the most recent Music Log edit.

Displaying Song History
Click [History] on the top Log Editor menu bar to view the song history for the currently-highlighted
song in the Music Log. Click [History] on the Alternate Song Tab or Log Diagnostics Tab to
display the History of any highlighted alternate song or unlogged song.

Scan for Log Errors [Missed Songs]
Click [Errors] to automatically scan for any "Missed Songs" on the Music Log. You will be moved to
that location on the Music Log and possible songs to be used at this location will be displayed.
"Missed Songs" are cause by the system being unable to select a song that meets all of your Rules.
You may manually drag and drop any song into this slot, even if it violates Rules.

Search for Items on Music Log
Click [Find] to search for Title, Artist, Music Category or any song property displayed on the Music
Log Editor screen.

Compute Length for a Segment of the Music Log
Using your mouse, hold the [Right Button] and move the mouse over the area for which you need
the total length. When you release the mouse button, the computed length will appear in the red text
box on the toolbar. Also see Format Clocks, ClockText to automatically print sweep and hourly totals
on the Music Log.

Print the Music Log
Click [Print] to print your Music Log. See also Printing Music Log to change the formatting of the
printed Music Log.

Send Log to Automation
Click [Automation] to create a Log in the appropriate format for the Automation system you selected
in Natural Music [Setup] [Station]. See Automation Interfacing

Listen to Songs
[Listen] launches your default MediaPlayer if you have one (e.g. Windows MediaPlayer, RealPlayer,
WinAmp, etc.) so you can listen to song IF it is available from the NM5 computer. NM5 uses the
WebAudioSource property as the filename it tries to play. If it cannot find that filename, it will open a
browse window so you can locate the actual audio cut.

Page 6-4

Natural Music User Manual

Music Log Diagnostics
After the Music Log is created, the Diagnostic Log can be displayed by selecting the Log
Diagnostics Tab in the Music Log Editor.

The Log Diagnostics Tab will list all songs Natural Music attempted to schedule in the currentlyhighlighted Music Log slot and why they failed to log. You may drag a song from the Log
Diagnostics Tab onto the Music Log to override the rule violation and force that song to be
logged.
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Music Log Statistics
Natural Music can display how much music you have scheduled in each hour of your log by clicking
the Log Statistics tab in the Music Log Editor. If the clock for that hour has a music limit, the Log
Statistics will also show the mm:ss +/- (over or short) for that hour.

You may click on any hour in the Log Statistics Window to jump to that hour in the Music Log.
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Music Log Printing
To print your Music Log, Click [Print] from the Music Log Editor screen. You will see a Music Log
Design Screen. Click the [View/Print] button to see the results on your design and to print the final
log.

Title Tab
You may enter a Heading and Sub-Heading to be printed on each Music Log page. You may also
select the time range for which the Music Log is to be printed.

Columns Tab
You may select which song properties are to be printed on the Music Log. You can add or remove
these properties by dragging them between the Include and Available boxes. To set the column
widths to be printed and to actually print the music log, click the [View/Print] button to see the results
on your design and to print the final log. On the Preview screen, you may drag the column dividers
left and right to set the column widths. Natural Music will remember these settings the next time
you print a log.

Page Setup
You may select the page margins, font and fontsize for the Music Log page.
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Recycle Music Hours
Recycling music hours is the ability to repeat exactly the same music schedule at another time and/or
on another day. Some users do this as not to "use up" their library for certain unimportant hours
overnight or when operating on low transmitter power. NM5 allows this to be done either manually or
[after version 5.0.188] automatically by a special recycle command in clocks. This not the same as
"gold recycling" in some other music schedulers which recycle only "gold" categories into hours
without counting them as played. Warning: This Recycle process cannot be UnDone!
Manual Recycle Example: "Recycle" the midday music (10A-3P) to the next day from 12Mid-5A:


In [Setup][Clocks], don't put any clock in the hours to be copied-TO so the hours will be empty.



In the Music Log Editor, open the music log into which you want to copy the recycled song list
and select [Edit] from the menu.



Then select [Recycle Music Hours].



You will need to specify the date for the "Source Log" (the log to be copied FROM). The Source
log and Target log may be the same log, but if it is the same log, the Copy-FROM and Copy-TO
times may not overlap. In other words, you cannot copy an hour onto itself within the same log.



You will need to specify the "Copy FROM Start Time" (the start time in the source log to be
copied FROM). In the example this would be 10:00:00AM



You will need to specify the "Copy FROM Stop Time" (the last time in the source log to be copied
FROM). In the example this would be 2:59:59PM



You will need to specify the "Copy TO Start Time" in the Target Log (the first time in the Target
log to be copied TO). In the example this would be 12:00:00AM



When you click [Copy] the hours from the Source log will be copied into the Target log starting
at the Target Start Time. In this example 10A - 2:59:59P would be copied from the specified
source log into the 12A - 4:59:59A time slot in the Target log.

Important Notes All existing items in the target log in the time range to be Copied-TO will be
deleted. No rule testing is done for recycled hours so there may be unreported song or artist
violations between the pre-existing log and the recycled songs. When songs within recycled hours
are copied into a Target log, they are not rotated to the bottom of their Music Category. This makes
the copied hours "not count" as far as Music Category rotation is concerned. However, the history for
the recycled song does reflect the actual play in the recycled hours of the Target log.
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Reconciling Scheduled Logs Against
Actual 'Aired' Logs
Reconciliation is an optional process whereby the NM5 Music Log is compared with an actual "aired"
log. You may do this manually, by simply deleting any unplayed items from an NM5 log in the Music
Log Editor. With some automation systems, NM5 can read the automation play-logs or air-logs. This
reconciliation process may be performed to
1. Obtain actual playtimes of the songs for performance reporting.
2. Recycle un-played songs to the top of the category stack so they rotate more evenly.

Reading an Automation System's Air-Log
To read an automation system's air-log or play-log, from the Music Log Editor select [ConvertLog][Reconcile]. Automated reconciliation is performed with only the following automation system
play-logs:
 Arrakis Digilink 3 & 4
 AudioVault
 AutoMate System
 BSI WaveStation/Simian
 Digital JukeBox
 Enco DAD
 MediaTouch
 Prophet NexGen
 Rivendell
 RDS Phantom
 Scott Studios AXS and SSDOS/SS32 Systems
 Salsa and Systemation

Use the [Browse] button to locate the automation play-log to be read and click [Reconcile] when
ready to start the process.

Any songs scheduled but not played by the automation will be removed from the
NM5 music log and returned to the top of the Music-Category stack IF that song had not been
scheduled on any NM5 music log after the time it was originally scheduled to play. If the song was
scheduled to play at a later date or time (as would be the case for currents or hot rotating songs), its
category stack position is NOT changed.

Any songs played by the automation but not scheduled on the NM5 music log will
be added to the NM5 music log. The song is rotated to the bottom of the Music-Category stack IF
that song had not been scheduled on any NM5 music log after the time it was originally scheduled to
play. If the song was scheduled to play at a later date or time (as would be the case for currents or
hot rotating songs), its category stack position is NOT changed.
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Reconciling Scheduled Logs Against
Actual 'Aired' Logs (cont)
Special Considerations when Reading a WaveStation/Simian Event List
The BSI WaveStation can save its event list in one of 2 formats:
 MS Access named as yymmdd.MDB
 ASCII named as yymmdd.LST
The format of the event-list file is user-selected in the [Tools][Program Options][General] tab of
the WaveStation. Natural Music can read either file. Just be sure to select the appropriate file type
from the dropdown box on the NM5 Log Reconciliation screen shown below.

Special Considerations when Reading a MusicReady [Windows version]
PlayLog The MusicReady creates a separate log for each deck. Be sure to read the log for the
deck number from which you play music.

Special Considerations when Reading a MediaTouch "Out" Log
Natural Music 5 can read the OUT log created by MediaTouch. Simply place it in a convenient folder
and point NM5 to it during log reconciliation.

Special Considerations when Reading a Prophet NexGen "Music Verify Log"
"Music Verify Logs" must be generated by NexGen so Natural Music can read exact runtimes for log
reconciliation. Here are the settings you need to use when configuring the "Music Verify Log" in
Prophet NexGen (All others are set to 0):
 Date
1
8
 Time
9
8
 Description
17
32
 Event Status
69
2
 Song Number
72
6
 Cut Number
79
3
Continued next page
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Reconciling Scheduled Logs Against
Actual 'Aired' Logs (cont)
Special Considerations when Reading Digilink Play Log
NM5 assumes Digilink 2/3/4 & Xtreme playlogs are exported in “Digilink” format from those systems.
NM5 assumes Digilink New~Wave / HD playlogs are exported from the Digilink report module as
“Music” format [not Spots or Digilink].

Special Considerations when Reading Rivendell “Technical Playout Report”
The Rivendell Technical Playout Report must be generated as a separate report for each day’s log.
To create the report in Rivendell:
RDAdmin > Manage Reports > Add > Enter Name > Select Export Filter > Technical Playout Report

Use the DEFAULT settings for this report in Rivendell EXCEPT:
1. Cart Number Parameters => Digits must be set to 6
2. Cart Number Parameters => Use Leading 0’s may be X or blank depending on how you
name / number your cuts in NM5. [e.g cart 234 or cart 000234]
3. Be sure to select click X next to Export Events From => Music Log
4. Change the filename wildcards in Linux Export Path to %m%d%y.txt to get a file named
mmddyy.txt.
Create the report and use it to reconcile the Natural Music log.

Natural Music User Manual

Page 6-11

Writing the Log to an HTML file
In the [Log Editor][Convert-Log][HTML File] select the type file you want. NM5 can create a single
HTML file for a day or a separate HTML file for each hour. You can also select which categories you
want to write to the file so you can exclude liners, jingles, etc.

Natural Music allows you to insert song data from your music log into a predefined HTML Template.
You can use any web design program you like to create the Template so it may be as simple or as
complex as you like. You must add a few special tags into the HTML template so NM5 knows
where (and what) you'd like to insert.

Natural Music Song Insertion Markers In the HTML template you need to designate the
area into which NM5 is to insert each song from the music log. This is done by inserting the following
words in the HTML template. The braces are required! For each song in the log, NM5 will duplicate
the HTML code between these start and end markers and insert the selected song fields.
{nm5Start}
{nm5End}

At the beginning of the HTML block in which NM5 is to insert data.
At the end of the HTML block in which NM5 is to insert data.

Natural Music Song Field Insertion Markers Between the 2 markers shown above you
place the HTML lines, tables or other HTML commands containing the NM5 song fields to be
inserted as shown below. These field names must be entered as text in the HTML file and enclosed
in {} and you may insert as many or as few as desired. When NM5 creates the final HTML file it will
insert these song fields into the HTML file at the locations in which the {} fields are placed.
{Album}
{Artist}
{CatalogNumber}
{Composer}
{Country}
{IRSC}
{Length}
{LinerNote}
{Other}
{Publisher}
{RecordLabel}
{Source}
{Style}
{Title}
{UPC}
{Year}

Other Natural Music Insertion Markers You may also place the following special tags in
the HTML template. These may be located anywhere in the HTML template.
{nm5Date}
Inserts the Log date.
{nm5Hour}
Inserts the Log hour.
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